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RMC70 Overview 
The RMC70 series offers the best combination of ease-of-use, 
price and performance for one- or two-axis systems.  The 
RMC70 gives smooth, precise, synchronized control of 
hydraulic, electric, and pneumatic axes, improving part quality 
and machine life. 

The RMC75 is the first in the series. Typically used in 
conjunction with a machine control PLC, the RMC75 boosts 
throughput by allowing time-critical sequences to be off-
loaded into its User Programs. 

Multiple communications choices support popular protocols 
such as RS-232 DF1 and Modbus/RTU, PROFIBUS, 
Ethernet/IP and Modbus/TCP and easy systems integration by 
mirroring PLC register addressing. 

The RMC70 base module consists of the CPU, communications, 
and one or two axes of motion control. Up to four expansion 
modules can be added in the field for additional capabilities. 

Delta’s RMCTools software speeds development with a 
wealth of setup, tuning and diagnostics features. 
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Figure 1.  Typical RMC70 and RMCTools installation. 
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How to Use this Guide 
Use this guide to help you get your system up and running. 
For best results, follow this guide step-by-step.  

Using the Help 
This guide will refer you to the extensive RMCTools help for 
information you will need when setting up your system. To 
access the help, click the Help menu in RMCTools and select 
Help Topics. 

Obtaining a User Manual 
The information contained in the RMC70 help is also 
available in the following formats: 

• As a Portable Document Format (PDF) file on the CD 
included with the RMC70 controller or available as a free 
download from Delta’s web site at deltamotion.com. 

• A printed manual can be purchased from Delta. Contact 
Delta by telephone at 360-254-8688 or email at 
sales@deltamotion.com. 
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Saving Configuration Settings 
Throughout the startup procedure, make sure you save the 
configuration changes you make or they may be lost! 
Configuration settings should be saved in the RMCTools 
software and in Flash memory in the RMC70.  

In this Startup Guide, whenever you are prompted to change 
parameters in RMCTools, remember to save the settings using 
this procedure: 

a) Save the settings in the RMC70 to Flash memory: 

• In RMCTools, on the Controller menu, click Update 
Flash.  

Note: If you do not update Flash memory, your changes 
to the RMC70 will be lost when power is removed! 

b) Save the Project file in RMCTools: 

• On the File menu, click Save. 
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Step 1: Mount the RMC70 
Mounting Options: 

• Symmetrical DIN 3 

• Panel-mount – See Appendix B for mounting hole 
dimensions 

Orientation: 
The RMC should be mounted upright on a vertical surface, 
such that the ventilation holes are on top and bottom. 

Clearance above and below: 
The amount of clearance required depends on the maximum 
ambient temperature: 

Ambient Temperature Clearance 
122 - 140°F (50 - 60°C) 3 in (7.6 cm) 
86 - 122°F (30 - 50°C) 2 in (5.1 cm) 
Less than 86°F (30°C) 1 in (2.5 cm) 

Grounding 
Make sure to properly ground the RMC70. If mounted on a 
DIN rail, the RMC70 will conduct to the DIN rail. The 
RMC70 shell is electrically connected its Case pins. 
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Step 2: Add Expansion Modules 
If your RMC70 is to have any expansion modules, and they 
are not yet installed on the RMC70, add them now. Follow the 
instructions included with each expansion module to attach it 
to the RMC70 and wire it. 

Note: 
Make sure power is removed from the RMC70 before adding 
expansion modules! 

Expansion modules can be added in any order. A maximum of 
4 expansion modules may be added. The RMC70 will not 
recognize more than 4 expansion modules total. In addition, 
the RMC70 will not support more than 2 Q1 modules. 

Note: 
Do not add more than 4 expansion modules! Adding more 
than 4 expansion modules may burden the RMC70 circuitry! 
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Step 3: Apply Power 
The RMC70 requires a +24V power supply. 

Power Supply Requirements 
• Voltage: +24VDC  ( 21.6 – 26.4VDC) 

• Current rating: Minimum 500 mA 

Connect Power 
a) Connect 24VDC to the RMC70 according to the diagram 

of your controller type: 

RMC75S 

RMC75S

{AC Line

Power
Supply

Pwr +
Pwr Cmn

Case

PS Return
+ 24Vdc PS

 
RMC75P, RMC75E 

RMC75P or RMC75E

{AC Line

Power
Supply

Pwr +
Pwr Cmn

Case

PS Return
+ 24Vdc PS
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 Step 4: Install RMCTools 
PC Requirements 

• Processor: Intel Pentium or AMD equivalent, 200 MHz 
or higher. 

• Operating System: Microsoft Windows Vista, Windows 
XP, Windows 2000, Windows Me, Windows 98, or 
Windows NT 4.0. 
Note: The USB driver used to connect to the RMC75E 

module is not supported on Windows NT. 
Note: Windows NT 4.0 requires SP6 and IE 4.0 or later. 

• RAM: 64MB   

• Hard Disk Space: 20MB of available hard disk space  

• Display: 1024x768 VGA display with 16-bit color or 
better 

• Accessories: Mouse or pointing device  

Installation 
You can install RMC70 Tools from the CD that shipped with 
the RMC, or by downloading it from Delta’s download page at 
www.deltamotion.com/dloads/. 

To install from the CD: 

a) Insert the CD and wait for the splash screen to appear. 
Click Install RMCTools. Follow the instructions for 
installation.  
If the splash screen does not automatically open, run the 
autorun.exe file. 
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To install by downloading: 

a) Go to Delta’s download website at 
http://www.deltamotion.com/dloads/ 

b) Locate the rmctoolsse.exe file, click it and save it to your 
computer. 

c) Run rmctoolsse.exe and follow the instructions. 

Start RMCTools 
To start RMCTools, click the Start menu, click 
Programs and then RMCTools. 

Note: It is also possible to run RMCTools directly from the 
CD without installing it on your PC. To do this, insert the 
RMC70 CD, wait for the splash screen to appear, and click 
Run RMCTools from CD. 

 



RMC70 Startup Guide   

10  Delta Computer Systems, Inc. 

Step 5: Connect RMC70 to PC 
The method of connecting your PC to the RMC70 series 
controller depends on which RMC70 controller you have. 

Connecting to RMC75S or RMC75P 
To connect the RMC75S or RMC75P to your PC, you need a 
Null-modem, DB-9, female-to-female cable. If you make your 
own cable, pins 2 and 3 must be crossed over, and pin 5 must 
be straight-through. 

a) Plug the cable into the RMC75 port labeled RS-232 
Monitor. 

b) On the PC, plug the cable into a serial port. Note which 
serial port it is. You will need to know this later. 

Connecting to RMC75E 
You can connect to the RMC75E via USB or Ethernet. 

Via USB 
Connecting to the RMC75E via USB requires a standard A to 
B USB cable. This is the same USB cable that is used for 
many PC peripherals, such as printers, scanners, etc. This 
cable is readily available at any store that sells electronics. 

a) Connect the USB cable to the PC and to the RMC75 port 
labeled USB Monitor. After a few seconds (you may 
need to wait a bit), a window will open indicating that 
new hardware was found and the USB driver is being 
installed. After the window closes, continue to the next 
step. 

Via Ethernet 
Make sure both the RMC75E and the PC are connected to the 
same Ethernet network. 
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Step 6: Start a new RMC70 Project 
Start a new project: 

a) In RMCTools, in the Startup dialog, choose Create a 
New Project and click OK. If the Startup dialog is not 
open, click on the File menu, choose New and then 
Project. 

b) In the New Project Wizard, enter the project name, the 
path where you want to save the project, and the author’s 
name. 

c) Ensure that the Start the New Controller Wizard box is 
checked. 

d) Click Finish. 

e) In the New Controller Wizard, enter a Controller Name, 
select Automatically Detect the Controller 
Information, and click Next. 

f) RMC75E: 
Click USB or Ethernet and click Next. Wait a few 
seconds while RMCTools finds the RMC75s connected to 
the PC via USB or Ethernet. Click the desired RMC75 
and click Next. 

Note: If your RMC75 does not appear, click Help for 
instructions on how to fix the problem.  

RMC75S or RMC75P: 
Select the serial port you are using to communicate to the 
RMC70 and click Next. Ensure that the serial port is set 
to the same port that you connected the serial cable to 
earlier. 

g) RMCTools will connect to the RMC75. The wizard will 
show the part number of the controller that it has 
connected to. Click Finish to add it to the project. 
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Project Pane 
The Project pane should now be visible in RMCTools, as 
shown in Figure 2. If it is not visible, open it as follows: on the 
View menu, click Project. 

 

Figure 2: Project Pane 

Go Online 
In order to view the data in the controller, RMCTools must be 
online, or communicating, with the controller. In the Project 
pane, the RMC70 icon has a red circle with a bar through it 
when the controller is offline, as shown in Figure 2. 

To go online: 

a) In the Project pane, click the controller, so that is 
highlighted, as shown below. 

 

b) Click the Go Online button  on the toolbar. If 
RMCTools successfully goes online with the controller, 
the red circle around the RMC70 icon in the Project pane 
will disappear, as shown below. 
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To go offline: 

a) In the Project pane, click the controller. 

b) Click the Go Offline button  on the toolbar. A red 
circle will appear over around the RMC70 icon in the 
Project pane. 

 

Define the Axes 
The user has full flexibility in defining the internal RMC70 
axes by assigning them to the hardware. A few examples of 
axes definitions: 

• An axis is defined as a position control axis and uses the 
Axis 0 connector Control Output and the Axis 0 feedback.  

• An axis is defined as a reference axis and uses the analog 
input from an A2 expansion module. 

• An axis is defined as a Control Output Only axis and uses 
the Axis 1 connector Control Output.  

• An axis is defined as a position-force axis and uses the 
Axis 0 connector Control Output, the Axis 0 connector 
feedback, and the two analog inputs an AP2 expansion 
module. 

You should view the axis definitions to ensure they are what 
you want.  

Note: If you need any pressure or force control, or have 
reference axes, you will probably need to change the default 
axis definitions.  

To view the axis definitions: 

a) In the Project pane, click the controller. 
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c) On the Controller menu, click View/Edit Axis 
Definitions. 

d) The box displays the RMC70 axes, along with a 
description of each. To see which hardware is assigned to 
which axis, click the axis in the box. The image below 
shows which hardware is assigned to the axis. 

To change the axis definitions:  

a) In the View/Edit Axis Definitions dialog, click New to 
add an axis, click Change to edit an axis, and click 
Remove to remove an axis. For more details, click the 
Help button. 

 

PROGRAM mode and RUN mode 
When the RMC70 starts up, it is in PROGRAM mode and the 
axes are not enabled. In order to issue motion commands to an 
axis (other than the Direct Output command), the axis must be 
enabled. 

In order to run User Programs or the PreScan Table, the 
controller must also be in RUN mode. The RUN Mode (98) 
command enables all the axes and puts the RMC70 in RUN 
mode. 

a) On the RMCTools toolbar, click the Go Online button 
. 

b) On the toolbar, click the RUN Mode button . 

Note: The RMC can perform motion control in both RUN 
mode and PROGRAM mode. RUN mode is required only for 
the User Programs and the PreScan table. 
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Step 7: Connect an Actuator 
Now will connect and verify an actuator, such as a hydraulic 
valve or a motor. 

Tip: The Event Log is your best trouble-shooting tool. If you 
run into problems or the RMC70 reports errors, use the Event 
Log to find out what happened or didn’t happen. For details, 
see the Event Log topic in the RMCTools help. 

Tip: The RMC70 can simulate an axis. You can learn how to 
move and tune an axis without being connected to a real 
system. See the Simulate Mode topic in the RMCTools help 
for more details. 

Wire the Actuator 
a) Important: Turn off power to the RMC70, the feedback 

device, and the actuator before connecting any wires! 

b) Wire each actuator to the RMC according to the 
instructions in Appendix A: Wiring. 

c) After wiring, re-apply power to the RMC70, the feedback 
device, and the actuator. 

Test Actuator Motion 
Note: Read this section completely before executing any 
commands on the RMC70. 

To test the actuator, you will supply a Control Output voltage 
from the RMC70 to the actuator. Before doing this, make sure 
that the axis may safely move in either direction! 

Note:  Verify that Simulate Mode is NOT checked in the 
Simulate section on the All tab of the Axes Parameters pane 
in the Axis Tools. If you make changes to the Axes 
Parameters, you must click the Download button  or press 
Ctrl+D to apply the changes to the RMC70. 
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a) In RMCTools, go online with the controller (see the Go 
Online section on page 12). 

b) Click the Axis Tools button  on the toolbar. 

c) In the Axis Status Registers pane, look at the Control 
Output register on the Basic tab. It should be 0. 

d) If the Command Tool is not visible in RMCTools, open it 
as follows: On the View menu, click Command Tool. 

e) In the Command Tool, in the axis the actuator is 
connected to, click the Cmd box. 

f) In the Cmd box, enter the Direct Output (9) command. 
This can be done in three ways: 

• Type “D” and then choose the Direct Output (9) 
command.  

• Type “9” and then choose the Direct Output (9) 
command. 

• In the Cmd box, click the ellipsis button . Expand 
Motion Commands, expand Open Loop, and 
double-click Direct Output. 

g) In the Output box, enter “0.1”. 

h) In the Ramp Rate box, enter “100”. 
When you issue the command in a later step, these values 
will cause the Control Output voltage to change to 0.1 V 
at a rate of 100 V/sec. 

Caution: Use the Direct Output command with extreme 
caution! It disables the safety features of the RMC! 

i) In the next step, you will issue the Direct Output 
command. If the motion causes problems, be prepared to 
quickly stop the axis by clicking the Fault Controller 
button ( ) on the toolbar. 
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j) In the Command Tool, click Send Command, or press 
Alt+S. 

k) The Control Output (in the Axis Status Registers pane) 
should be “0.1”. If you measured the Control Output with 
a voltmeter, it should measure roughly 0.1 V. 

l) Observe the system and note whether the system is 
moving forward or backward. 

One of two things could have happened at this point: 

• The actuator moved. 
In this case, go to step m. 

• The actuator did not move. 
In this case check the output voltage, check that the 
actuator is enabled, verify that the axes are 
initialized, verify the Simulate bit is not set (on the 
All tab of the Axis Parameters pane, under the 
Simulate section), and repeat the process above with 
a larger Output. Some systems may require much 
more than 0.1 volt to move. 

m) Now stop the axis: 
In the Command tool, enter “0” in the Output box and 
click Send Command, or press Alt+S, to turn the 
Control Output voltage off. 

n) Now you will verify that the axis moves in the opposite 
direction also:  
In the Command tool, enter “-0.1” (or a higher value if 
that is required to move the axis) in the Output box and 
click Send Command, or press Alt+S. The Control 
Output in the Axis Status Registers pane should reflect 
the value you entered and the axis should move in the 
opposite direction. 
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Step 8: Connect Feedback Device 
Now that you have connected a working actuator, you will 
connect and verify a feedback device, such as an MDT 
(Magnetostrictive Displacement Transducer), SSI encoder, or 
an analog transducer. 

Wire the Transducer 
a) Important: Turn off power to the RMC70 and the 

feedback device before connecting any wires! 

b) Wire each feedback device to the RMC according to the 
instructions in Appendix A: Wiring. 

c) After wiring, re-apply power to the RMC70 and the 
feedback device. 

Go Online and Configure Feedback 
a) In RMCToools, go online with the controller (see the Go 

Online section on page 12). 

b) In the Project pane, click the RMC controller. 

c) On the RMCTools toolbar, click the Axis Tools button  
. 
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d) In the Axis Parameters pane, on the Setup tab, you will 
configure certain parameters depending on the type of 
input you are using. 
Refer to the procedure for your module: 

Module Transducer Type Page: 
MA1 or MA2 MDT 19 
 SSI 20 
AA1 or AA2 Analog 20 
QA1 or QA2 Quadrature 21 
AP2 or A2 Analog volts or current 21 
Q1 Quadrature 21 

 
Configure MA Axis Module Feedback – MDT  

The procedure below should be followed for each MDT-input 
axis tied to the MA module. 

a) In the Axis Parameters pane, on the Setup tab, in the 
Feedback Type register, select MDT. 

b) In the MDT Type register, select the type of MDT 
transducer you have. This information should be available 
on the MDT datasheet. The options are: 

• Start/Stop Rising Edge 

• Start/Stop Falling Edge 

• Pulse-Width Modulated 

c) To apply the changes to the RMC70, click the Download 
button  or press Ctrl+D.  

d) Continue to the Verify Feedback section on page 22. 
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Configure MA Axis Module Feedback –  SSI 
The procedure below should be followed for each SSI-input 
axis tied to the MA module. 

a) In the Axis Parameters pane, on the Setup tab, in the 
Feedback Type register, select SSI. 

b) From the information in your SSI data sheet, enter the 
correct value for each of these registers: 

• SSI Format - Binary or Gray 

• SSI Data bits (e.g. 24) 

• Absolute/Incremental 

• Linear/Rotary 

Note: For help on any of these parameters, click the cell 
and press F1. 

c) To apply the changes to the RMC70, click the Download 
button  or press Ctrl+D. 

d) Continue to the Verify Feedback section on page 22. 

Configure AA Axis Module Feedback 
The procedure below should be followed for each axis tied to 
the AA module. 

a) In the Axis Parameters pane, on the Setup tab, in the 
Input Type register, select Voltage or Current. 

b) To apply the changes to the RMC70, click the Download 
button  or press Ctrl+D. 

c) Continue to the Verify Feedback section on page 22. 
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Configure A2 or AP2 Module Feedback 
a) In the Axis Parameters pane, on the Setup tab, under the 

Secondary Control Setup, in the Input Type register, 
select Voltage or Current. 

b) If the axis is a dual-loop axis, make sure to configure the 
secondary input under the Secondary Control Setup 
section. Set the Input Type register to Voltage or 
Current. If the secondary input is dual-input 
(differential), both inputs must be of identical types and 
are specified by only one Input Type parameter. 

c) To apply the changes to the RMC70, click the Download 
button  or press Ctrl+D. 

d) Continue to the Verify Feedback section on page 22. 

Configure QA or Q1 Module Feedback 
The QA and Q1 module do not require any configuration to 
read the encoder. Simply wire the encoder to the inputs. 

a) Continue to the Verify Feedback section on page 22. 
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Verify Feedback 
a) Click the Axis Tools button  on the toolbar. In the 

Axis Status Registers pane, on the All tab, expand the 
Feedback section. Look at the Counts register (if you are 
using analog feedback, look at the Volts or Current 
register). It may be changing slightly. 
If you are verifying pressure or force feedback on a 
position-pressure/force axis, look at the Volts or Current 
in the Pressure/Force Feedback section.  

b) Move the axis (as you learned in the Connect an 
Actuator section) and look for a corresponding change in 
the Counts (or Volts or Current) register. If it does not 
change properly, recheck the wiring, verify that the 
parameters on the Setup tab in the Axis Parameters pane 
are correct, and check for changing Counts (or Volts or 
Current) again. When it is working correctly, proceed to 
the next step. 

c) Determine which direction you want the Actual Position 
to be increasing as the axis moves. For example, you may 
want the Actual Position to increase as the hydraulic 
cylinder extends. The actual value of the Actual Position 
is not important here, only the direction of increase or 
decrease. 

d) If you changed any parameters, on the Controller menu, 
click Update Flash. This stores your changes in the 
RMC70 even in the event of a power outage. Press Ctrl+S 
to save the project file. 
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 Step 9: Setting the Scale and Offset 
The Scale and Offset parameters convert the Counts or Volts 
or Current from the transducer into meaningful measurement 
units. RMCTools provides Scale/Offset wizards to help you 
calculate these parameters. 

Before starting, determine approximately what the positions 
should be at either end of travel. This will help you verify later 
that you performed the Scaling and Offset procedure correctly. 

To set the Scale and Offset: 

a) Open Axis Tools by clicking the Axis Tools button  
on the toolbar. In the Axes Parameters pane, select the 
Setup tab. Expand the Tools and Wizards section. Click 
Launch in the axis for which you wish to set the Scale 
and Offset. 

b) In the wizard, follow the directions. For help, press the 
Help button. 

c) When you have completed the wizard, you must 
download the parameter changes to the RMC70. To do 
this, in Axis Tools, click the download button  or press 
Ctrl+D to apply the changes to the controller. 

d) On the Controller menu, click Update Flash. This stores 
your changes in the RMC70 even in the event of a power 
outage. 

e) Press Ctrl+S to save the project. 

 

Tip: If the wizard does not work for your system, you can 
manually determine the Scale and Offset parameters. See the 
Scaling topic in the RMCTools help for details. 
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Step 10: Set the Output Polarity 
After setting the Scale and Offset parameters, you must set the 
polarity of the Control Output. 

 It is essential that the Actual Position (or Pressure, Force, or 
Velocity) increases when a positive output voltage is specified 
with Direct Output command. If this condition is not met, you 
will not be able to control the axis in closed loop. 

a) In the Command Tool, choose the Direct Output (9) 
command. In the Output box, enter a positive value that 
is large enough to move the axis. In the Ramp Rate box, 
enter “100”. 

b) Click Send Command. 

c) Observe the Actual Position register on the Basic tab of 
the Axis Status Registers pane and note whether it is 
increasing or decreasing: 

• If the Actual Position is increasing, the Control 
Output polarity is correct. Proceed to step 11. 

• If the Actual Position is decreasing, you must 
change the Output Polarity: 

i. In the Axis Parameters pane, on the Setup tab, 
expand the Primary Control Setup section. 

ii. Set the Invert Output Polarity parameter to the 
opposite of its current sate by double-clicking it. 

iii. To apply the changes to the RMC70, click the 
Download button  or press Ctrl+D. 

iv. Remember to Update Flash and save the project. 
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Step 11: Tuning 
In order to control an axis in closed-loop control, it must first 
be tuned. Refer to the RMCTools help for the tuning 
procedure: 

a) In RMCTools, on the Tools menu, click Plot Manager. 
In the Plot Manager, in the Plot History pane, click the 
Tuning Tools tab. 
During the tuning process, you will set all the Gain and 
Feed Forward registers in the Axis Parameters section of 
the Tuning Tools pane. 

b) Read the appropriate topics describing how to tune an 
axis:  

i. Press F1 to open the RMCTools help. 

ii. Click the Index tab, type “tuning” and double-click 
about. The Tuning Overview topic will open. 

iii. Read the entire Tuning Overview topic. Autotuning 
is the easiest and fastest way to tune your system. 
Click the autotuning link to learn how to autotune 
your system.  
If you instead wish to tune your system manually, 
click one of the Manual Tuning Procedure links for 
precise directions on how to tune the system. For 
most applications, the Tuning a Hydraulic Position 
Axis or Motor in Velocity Mode procedure is the 
correct one.  

c) After tuning, on the Controller menu, click Update 
Flash. This stores your changes in the RMC70 even in the 
event of a power outage. 

d) Press Ctrl+S to save the project. 
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Continuing the Motion Application 
After setting up and tuning the RMC70, it is ready to be 
programmed and integrated into the rest of your application. 
The RMC70 has numerous features to assist you. The major 
components are listed here to guide you when continuing your 
motion application. 

Event Log 
The Event Log is your best trouble-shooting tool. The Event 
Log reports nearly all the activity on the RMC70, including 
communications, commands, errors, and configuration. For 
details, see the Event Log topic in the RMCTools help. 

Whenever you have difficulties, the Event Log should be one 
of the first places to look! 

Communications 
The RMC70 is typically used in conjunction with a PLC or 
other host controller. The basic purpose of communications is 
to issue commands to the RMC70 and read status information.  
Available RMC70 communications types include PROFIBUS-
DP, and RS-232/485 Serial. 

See the Communications section of the RMCTools help for 
more detailed information. 

Discrete I/O 
Discrete I/O augments the communications of the RMC70. 
Discrete I/O is often faster than the communications, and is 
therefore well-suited for starting a sequence in the RMC70 at 
a specific time. Up to 32 discrete I/O can be added to the 
RMC70. Each  I/O point is individually configurable in 
software as inputs or outputs. See the Discrete I/O topic in the 
RMCTools help for details. 
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Some example uses of discrete I/O: 

• General input and output. 

• Affect flow of User Programs. 

• Start or Stop User Programs. 

Commands 
The RMC70 has a rich set of pre-programmed commands that 
perform anything from simple moves to complex motion to 
system control. For a list of all the RMC70 commands, see the 
Command List topic in the RMCTools help. 

User Programs 
A User Program carries out a sequence of commands on the 
RMC70. This allows the RMC70 to respond to events within 
its control-loop time rather than the scan rate of a PLC or 
other host controller. It also reduces the PLC programming 
required. 

A User Program consists of multiple steps linked together in 
sequences. Each step can issue any RMC70 command to one 
or several axes. The link types allow branching and looping, 
waiting for conditions and many other features. Simple and 
complex mathematical operations are also possible in the user 
program.  

A User Program runs on a task. Each task can run one user 
program at a time. The RMC70 has four tasks. Therefore, an 
RMC70 controller may run up to four User Programs 
simultaneously. 

For details on creating and running User Programs, see the 
User Programs topic in the help. 

Variables 
Variables help make the User Programs very flexible and easy 
to maintain. Variables can be used to effortlessly change 
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programs and easily modify User Program parameters via a 
PLC. Variables can also be used to store data. 

For details on using variables, see the Variables topic in the 
help. 

 

PreScan Table 
Use the PreScan Table starts or stops User Programs based on 
conditions defined by the user. The PreScan evaluates all the 
conditions in the PreScan table every loop time. When a 
condition becomes true, the corresponding User Programs are 
started or stopped. 

Some example uses of the PreScan Table are: 

• Start a User Program when a discrete input turns on. 

• Automatically start a User Program when the RMC70 
starts up. 

• When an error condition occurs, automatically start a 
User Program to handle it. 

See the PreScan Table topic in the RMCTools help for 
details. 
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Diagnostic Tools 
This section describes diagnostic tools of RMCTools that will 
aid you in monitoring and troubleshooting your system. 

Event Log 
The Event Log Monitor displays all events that have occurred 
in the controller, such as issued commands, changed 
parameters and errors. The Event Log Monitor is an important 
aid in troubleshooting. 

The Event Log can help you: 

• Determine if a command was successfully issued. The 
entire command, with parameters, is displayed. 

• Find out which, if any, error occurred. 

• See where a command was issued from, for example, 
from a PLC, from a User Program or from the Command 
Tool. 

To open the Event Log: 

• In the Project Pane, expand the controller, and double-
click Event Log . 

Note: Do not underestimate the usefulness of the Event Log! 
When you don’t know what happened, or why something did 
not happen, look at the Event Log. 

Plots 
The RMC70 provides very flexible plotting capabilities. 
Virtually any register in the RMC70 can be plotted, and 
multiple registers may be plotted simultaneously. You can 
easily capture events with the plot trigger. For details on using 
plots, see the Plots topics in the help. 
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Status Registers 
Status Registers provide information on the status of each 
axis. The RMC70 has numerous Status registers to provide 
monitoring and troubleshooting capabilities for nearly every 
aspect of the controller.  

To maximize the troubleshooting benefit of the status 
registers, include them in plots.  

Status Bits 
The Status bits status register is a collection of bits that 
provide a summary of the state of the axis.  

Error Bits 
The Error bits status register is a collection of bits that indicate 
the errors on an axis. 

Error bits are important to the safety features of the RMC70. If 
an error bit turns on, a halt will occur if the Auto Stops are 
configured to do so. By default, the Auto Stops are set to 
cause an Open Loop Halt and Disable Drive. You can 
configure the Auto Stops to specify which type of halt, if any, 
should occur for each error bit. See the AutoStop topic in the 
help for more details. 

Error bits are latched. Any motion command will clear the 
errors for which the underlying error condition has gone away. 
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Appendix A: Wiring 
This appendix describes how to wire the RMC70. Use the 
table below to find the wiring diagram you need. For 
expansion module wiring, consult the wiring diagram you 
received with it, or use the RMC70 Tools help. For 
communications wiring, consult the RMCTools help. 

  Page 
General Wiring Information........................................32 
Power..............................................................................33 
MA Axis Module 

Control Output, Enable Output, Fault Input ............34 
MDT Transducer......................................................35 
SSI Transducer.........................................................36 

AA Axis Module 
Control Output, Enable Output, Fault Input ............34 
Voltage Feedback Transducer..................................38 
Potentiometer ...........................................................39 
Current Feedback Transducer ..................................39 

 
QA Axis Module 

Control Output, Enable Output, Fault Input ............34 
Quadrature Encoder .................................................41 
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General Wiring Information 
For CE compliance and to minimize electrical interference: 

• Use twisted pairs for all wiring where possible. 

• Use shielded cables for all wiring. 

• Keep RMC wiring separate from AC mains or 
conductors carrying high currents, especially high 
frequency switching power such as conductors 
between servo drives and motors or amplifiers and 
proportional valves. 

For UL and C-UL compliance: 

• Power supply must be Class 2. 

• All RMC70 inputs and outputs must be connected to 
Class 2 circuits only. 
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Wiring Power 
Connect + 24V DC to the RMC70 according to the following 
diagrams: 

RMC75S 

RMC75S

{AC Line

Power
Supply

Pwr +
Pwr Cmn

Case

PS Return
+ 24Vdc PS

 
 

RMC75P 
RMC75P

{AC Line

Power
Supply

Pwr +
Pwr Cmn

Case

PS Return
+ 24Vdc PS

 
 

 



RMC70 Startup Guide   

34  Delta Computer Systems, Inc. 

Wiring for all Axis Modules 
Control Output, Enable Output, and Fault Input 
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MA Module MDT Transducer Wiring 
See page 37 for the MA module pin-out description. 
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MA Module SSI Transducer Wiring 
See page 37 for the MA module pin-out description. 
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MA Module Pin-out  
Pin Function 
Flt In + Fault Input 
Flt In - Fault Input 
En Out + Enable Output 
En Out - Enable Output 
Ctrl Out Control Output, +/- 10 V 16-bit Analog 
Cmn Common 
 MDT Transducer SSI Transducer 
Int/Clk + + Interrogation + Clock 
Int/Clk - - Interrogation - Clock 
Ret/Dat 
+ 

+ Return + Data 

Ret/Dat - - Return - Data 
  
Cmn Common 
Case RMC70Chassis 
 

Note: The two Cmn  pins are electrically the same. 
Note: The user must supply power for the transducer. 
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AA Module Voltage Transducer Wiring 
See page 40 for the AA module pin-out description. 

Voltage Transducer, 4- or 5-Wire 

To minimize electrical interference:

Analog Voltage
Transducer

RMC70 AA module
12-Pin Connector

Pwr +
Pwr Cmn{AC Line

DC Power Supply
Case

Cmn
- Analog In

Jumper for 4-20 mA
+ Analog In + Analog Out

- Analog Out
Signal Cmn
+ Pwr
Cmn

- Do not jumper the RMC70 - Analog In directly to the RMC70
  Cmn!This connection should be made at the transducer.
- Use individually shielded twisted-pair wire.
- Typically, the cable shield should be connected
  to earth ground on one end only.
- If the transducer has only one Cmn, connect both the
  Power Supply Cmn and the RMC70 Cmn to it. For
  best results, make this connection at the transducer.

+ 10 Vdc Exciter

 Voltage Transducer, 3-Wire 

3-wire Analog 
Voltage Transducer

RMC70 AA module
12-Pin Connector

Pwr +
Pwr Cmn{AC Line

DC Power Supply

Case

Cmn
- Analog In

Jumper for 4-20 mA
+ Analog In + Out

+ Pwr
Cmn

To minimize electrical interference:
 - Do not jumper the RMC70 - Analog In directly to the
   RMC70  Cmn! This connection should be made at 
   the transducer to minimize electical interference.
 - Use individually shielded twisted-pair wire.
 - Typically, the cable shield should be connected
   to earth ground on one end only.

+ 10 Vdc Exciter
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AA Module Potentiometer with Exciter Pin 
Note: When using a potentiometer, use the Exciter pin to 
increase the accuracy of the analog to digital conversion. 

To minimize electrical interference:
 - Do not jumper the RMC70 - Analog In directly to the RMC70
   Cmn. This connection should be made at the transducer.
 - Use individually shielded twisted-pair wire.
 - Typically, the cable shield should be connected
   to earth ground on one end only.

Potentiometer
RMC70 AA module
12-Pin Connector

+ 10 Vdc Exciter
Cmn

- Analog In
Jumper for 4-20 mA

+ Analog In

Case

 

AA Module Current Transducer Wiring 

To minimize electrical interference:
 - Do not jumper the RMC70 - Analog In directly to the
   RMC70  Cmn! This connection should be made at 
   the transducer.
 - Use individually shielded twisted-pair wire.
 - If the transducer has only one Cmn, connect both the 
   Power Supply Cmn and the RMC70 Cmn to it. For
   best results, make this connection at the transducer.
 - If the transducer has no - Analog Out pin (only a Cmn), 
   connect the Power Supply Cmn, the RMC70 Cmn, and 
   the RMC70 - Analog In to it. For best results, make this
   connection at the transducer. Observe the first Note.

Analog Current
Transducer

RMC70 AA module
12-Pin Connector

Pwr +
Pwr Cmn{AC Line

DC Power Supply

Case

Cmn
- Analog In

Jumper for 4-20 mA
+ Analog In + Analog Out

- Analog Out
Signal Cmn
+ Pwr
Cmn+ 10 Vdc Exciter
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AA Module Pin-out  
Pin Function 
Flt In + Fault Input 
Flt In - Fault Input 
En Out + Enable Output 
En Out - Enable Output 
Ctrl Out Control Output, +/- 10 V 16-bit Analog 
Cmn Common 
Analog In + Signal + 
Jumper for 4-20 
mA 

Jumper for Current Transducer 

Analog In - Signal - 
Cmn Common 
+ 10 V DC Exciter 10 Volt source for potentiometer 
Case RMC70Chassis 
 

Note: The two Cmn  pins are electrically the same. 
Note: The user must supply power for the transducer. 
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QA Module Wiring 
See page 42 for the QA module pin-out description. 

DC Power Supply

{ Pwr Cmn
Pwr +

2: A+
1: A-
4: B+
3: B-

+A
-A Encoder

Cmn
-Z
+Z
-B
+B

Pwr +

RMC70 QAx module
25-Pin Connector

15: Z+
14: Z-

13 or 16: Cmn

Notes:
 - The A,B, and Z inputs accept only differential line
   driver (RS-422) signals. Single-ended (TTL)
   transducers are not supported.
 - The user must supply power for the transducer.
-  The Reg/Lim and Home inputs are compatible with signal
    levels from 12 to 24 V.They draw 2.7 mA max and turn on
    when the voltage across the input is greater than 6 V. The
    polarity is unimportant.

Shield

To turn on, apply 12 - 24 VDC
across the input18: Home -

19: Home +

To turn on, apply 12 - 24 VDC
across the input8: RegX/PosLim -

9: RegX/PosLim +

To turn on, apply 12 - 24 VDC
across the input6: RegY/NegLim -

7: RegY/NegLim +
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QA Module Pin-out  
Pin  QA1 Label QA2 Label Function 
1 A- A- A- from encoder 
2 A+ A+ A+ from encoder 
3 B- B- B- from encoder 
4 B+ B+ B+ from encoder 
5 n/c n/c No connection 
6 Reg Y/NegLim- RY/NL- 
7 Reg Y/NegLim+ RY/NL+ 

Registration Y or 
Negative Limit 

8 Reg X/PosLim- RX/PL- 
9 Reg X/PosLim+ RX/PL+ 

Registration X or 
Positive Limit 

10 n/c n/c No connection 
11 n/c n/c No connection 
12 Control Out CtrlOut Control Output 
13 Cmn Cmn Common 
14 Z- Z- 
15 Z+ Z+ 

Index pulse from 
encoder 

16 Cmn Cmn Common 
17 n/c n/c No connection 
18 Home- Home- 
19 Home+ Home+ 

Home Input 

20 FltIn- FltIn- 
21 FltIn+ FltIn+ 

Fault Input 

22 n/c n/c No connection 
23 n/c n/c No connection 
24 EnOut- EnOut- 
25 EnOut+ Enout+ 

Enable Output 

 

Note: The two Cmn  pins are electrically the same. 
Note: The user must supply power for the transducer. 
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Appendix B: Mounting Dimensions 
This sections contains mounting hole dimensions for the 
RMC70 series motion controller and expansion modules. Up 
to four expansion modules may be added to the right side of 
the RMC70 base module. 

Base Module 
RMC75S, RMC75P, RMC75E 

 
Note: Drawing is not 1:1 scale.
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Expansion Modules 
Notice that there are two different expansion module widths. 

 

D8 AP2, A2, Q1 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

Note: Drawings are not 1:1 scale. 
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